| This document covers ACE14VCT and ACE19VCT models |

Owner’s Manual

HIGH SPEED COMMERCIAL COMBINATION OVEN

CULITEK S

Keep these instructions for future
reference. If the equipment changes
ownership, be sure this manual
accompanies equipment. Please refer to
the SAFETY INSTRUCTIONS for important
safety information prior to using this oven
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IMPORTANT SAFETY INSTRUCTIONS
/\ RECOGNIZE THIS SYMBOL AS A SAFETY MESSAGE

/A WARNING

When using electrical equipment, basic safety precautions should be followed to reduce the risk of burns, electrical shock,
fire, or injury to persons including the following.

READ all instructions before using equipment.

READ AND FOLLOW the specific “PRECAUTIONS
TO AVOID POSSIBLE EXPOSURE TO EXCESSIVE
MICROWAVE ENERGY” on this page.

10.

Failure to maintain the oven in a clean condition could
lead to deterioration of the surface that could adversely
affect the life of the appliance and possibly result in a
hazardous situation;

11. See door cleaning instructions on page 18 of this
This equipment MUST BE GROUNDED. Connect only product safety manual.
to properly GROUNDED outlet. See “ GROUNDING /
EARTHING INSTRUCTIONS". 12. DO NOT heat baby bottles in oven. Baby food jars shall be
open when heated and contents stirred or shaken before
Install or locate this equipment ONLY in accordance with consumption, in order to avoid burns.
the installation instructions in this manual.
13. DO NOT operate this equipment if it has a damaged
Liquids or other foods, must NOT be HEATED in sealed cord or plug, if it is not working properly, or if it has been
containers since they are liable to explode. damaged or dropped.
Eggs in their shell and whole hard-boiled eggs should NOT 14, This equipment, including power cord, must be serviced
be HEATED in microwave ovens since they may explode ONLY by qualified service personnel. Special tools are
even after microwave heating has ended. required to service equipment. Contact nearest authorized
service facility for examination, repair, or adjustment.
Use this equipment ONLY for its intended use as described
in this manual. DO NOT use corrosive chemicals or vapors 15, DO NOT cover or block louvers or other openings on
in this equipment. This type of oven is specifically designed equipment.
to heat, cook, or dry food. It is not designed for industrial or
laboratory use. 16. DO NOT store this equipment outdoors. DO NOT use this
product near water — for example, near a kitchen sink, in a
This appliance is NOT intended for use by wet basement, a swimming pool, or a similar location.
persons(including children) with reduced physical, sensory
or mental capabilities, or lack of experience and knowledge, 17. DO NOT immerse cord or plug in water.
unless they have been given supervision or instruction
concerning use of the appliance by a person responsible for  18. Keep cord AWAY from HEATED surfaces.
their safety
19. DO NOT let cord hang over edge of table or counter.
CHILDREN SHOULD BE SUPERVISED to ensure that they
DO NOT play with the appliance 20. For commercial use only.

PRECAUTIONS TO AVOID POSSIBLE EXPOSURE TO
EXCESSIVE MICROWAVE ENERGY

DO NOT attempt to operate this oven with the door open since open door operation can result in harmful exposure to
microwave energy. It is important not to defeat or tamper with the safety interlocks.

DO NOT place any object between the oven front face and the door too allow soil or cleaner residue to accumulate on sealing

surfaces.

DO NOT operate the oven if it is damaged. It is particularly important that the oven door close properly and that there is no

damage to the:

1.door (bent)

2. hinges and latches (broken or loosened)
3. door seals and sealing surfaces.

The oven should not be adjusted or repaired by anyone except properly qualified service personnel.

SAVE THESE INSTRUCTIONS
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/A WARNING /A WARNING

To avoid risk of fire in the oven cavity:

A. DO NOT overcook food. Carefully attend oven when
paper, plastic, or other combustible materials are placed
inside the oven, due to the possibility of ignition.

B. Remove wire twist-ties from paper or plastic bags before
placing bag in oven.

C. If materials inside the oven ignite, keep oven door
CLOSED, turn oven off and disconnect the power cord,
or shut off power at the fuse or circuit breaker panel.

D. DO NOT use the cavity for storage. DO NOT leave
paper products, cooking utensils, or food in the cavity
when not in use.

Liquids such as water, coffee, or tea are able to be
overheated beyond the boiling point without appearing

to be boiling due to surface tension of the liquid. Visible
bubbling or boiling when the container is removed from
the microwave oven is not always present. THIS COULD
RESULT IN VERY HOT LIQUIDS SUDDENLY BOILING
OVER WHEN A SPOON OR OTHER UTENSIL IS
INSERTED INTO THE LIQUID. To reduce the risk of injury
to persons:

i. DO NOT overheat the liquid.
ii.  Stir the liquid both before and halfway through heating it.
iii. DO NOT use straight-sided containers with narrow necks.

iv. After heating, allow the container to stand in the
microwave oven for a short time before removing the
container.

v. Use extreme care when inserting a spoon or other utensil
into the container.

/A CAUTION

To avoid personal injury or property damage, observe the following:

1. DO NOT deep fat fry in oven. Fat could overheat and be
hazardous to handle.

2. DO NOT cook or reheat eggs in shell or with an unbroken
yolk using microwave energy. Pressure may build up and
erupt. Pierce yolk with fork or knife before cooking.

3. Pierce skin of potatoes, tomatoes, and similar foods before
cooking with microwave energy. When skin is pierced,
steam escapes evenly.

4. DO NOT operate equipment without load or food in oven
cavity.

5. Microwave popcorn should not be popped in oven.

6. DO NOT use regular cooking thermometers in oven. Most
cooking thermometers contain mercury and may cause an
electrical arc, malfunction, or damage to oven.

7. DO NOT use metal utensils in oven.

8. DO NOT use aluminum foil in oven

9. Never use paper, plastic, or other combustible materials
that are not intended for cooking.

10. When cooking with paper, plastic, or other combustible
materials, follow manufacturer’s recommendations on
product use.

11. DO NOT use paper towels which contain nylon or other
synthetic fibers. Heated synthetics could melt and cause
paper to ignite.

12. DO NOT heat sealed containers or plastic bags in oven.
Food or liquid could expand quickly and cause container
or bag to break. Pierce or open container or bag before
heating.

13. To avoid pacemaker malfunction, consult physician or
pacemaker manufacturer about effects of microwave
energy on pacemaker.

14. An authorized servicer MUST inspect equipment annually.
Record all inspections and repairs for future use.

SAVE THESE INSTRUCTIONS
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Grounding & Installation

Grounding/Earthing Instructions

/\ WARNING

Oven MUST be grounded. Grounding reduces risk of electric shock

@ , by providing an escape wire for the electric current if an electrical To avoid risk of electrical shock or

death, this oven must be grounded
and plug must not be altered.

short occurs. This oven is equipped with a cord having a grounding
wire with a grounding plug. The plug must be plugged into an outlet
that is properly installed and grounded.

Consult a qualified electrician or servicer if grounding instructions are not completely understood,
or if doubt exists as to whether the oven is properly grounded.

Do not use an extension cord.

If the product power cord is too short, have a qualified electrician install a three-slot receptacle. This oven should be plugged into
a separate circuit with the electrical rating as provided in product specifications (available on Culitek’s website at
culitekequipment.com) and the oven’s serial plate / rating label. When the oven is on a circuit with other equipment, an
increase in cooking times may be required and fuses can be blown.

EXTERNAL EQUIPOTENTIAL EARTHING TERMINAL (export only)

Equipment has secondary earthing terminal. Terminal provides external earthing connection used in addition to earthing
prong on plug. Located on outside of oven back, terminal is marked with symbol shown at right

Installation /\ WARNING

Excessive Weight Hazard

Unpacking Oven

* Inspect oven for damage such as dents in door or inside oven cavity.

» Report any dents or breakage to source of purchase immediately.
Do not attempt to use oven if damaged.

* Remove all packing materials from oven interior.

* If oven has been stored in extremely cold area, wait a few hours before
connecting power.

Use two or more people to move
and install oven. Failure to do so can
result in back or other injury

Radio Interference

» Microwave operation may cause interference to radio, television. Reduce or
eliminate interference by doing the following:

» Clean door and sealing surfaces of oven according to instructions in
“Care & Cleaning” section.

Oven Placement b
» Do not install oven next to or above source of heat, such as pizza oven
or deep fat fryer. This could cause oven to operate improperly and could shorten

life of electrical parts.
» Do not block or obstruct oven filters. Allow access for cleaning.
* Install oven on level counter-top surface.
» If provided, place warning label in a conspicuous place close to oven.
» Outlet should be located so that plug is accessible when oven is in place.

OVEN CLEARANCES

A. Allow at least 4” (10 cm) of clearance around top of oven. Proper air flow around
oven cools electrical components. With restricted air flow, oven may not operate
properly and life of electrical parts is reduced.

B. There is not an installation clearance requirement for the back of the oven.
C. Allow at least 17 (2.54 cm) of clearance around sides of oven.
D. Install oven so oven bottom is at least 3 feet (91.5 cm) above floor.

©2021 Culitek Equipment Part No. 20290304
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Cooking Tips

Oven Temperature

* Oven can be preheated to the

following temperature range:
+ 200°-475°F (95°- 250°C)

* The most frequently used oven
temperature is 475°F (250°C).

» Use only one temperature for all
your menu items to avoid cooking
inconsistency.

* Reduced oven temperature may be
needed for baking or if product is

cooked for an extended period of time.

Microwave Settings

» 11 different power levels (0% lowest
to 100% highest) control intensity of
microwave energy.

* Microwave energy cooks the food
and increases the internal food
temperature.

* Food containing high water, fat and
salt content raises its temperature
faster with high microwave power
level.

» Decreasing microwave power is
recommended when product is thick
and takes longer to cook to avoid
drying out food.

Stage Cooking

Allows operator to use up to four different
cooking cycles or stages consecutively
without repeated input from the operator.
Stage cooking aids in retaining the quality
of frozen and delicate foods. It can be set to
defrost food initially, then cook it, and then
finish with more toasting/browning.

Note: Combined total cook time

cannot exceed 20:00

Example: Pizza
Total Cook Time:3:45
Temperature: 475°F (250°C)

STAGE| TIME % MW POWER
1 1:00 80%
2 1:30 30%
3 1:15 50%
4 - -

Stage one thaws and begins cooking
process. Stage two continues cooking

process without drying out pizza crust. Stage

three increases the internal temperature of
the pizza.

©2021 Culitek Equipment

Best Practices

»  Remove food from oven at end of cycle. ltems will be hot when finished cooking. Use oven
mitt, tongs, or pizza paddle to safely remove items from oven.

* Place cookware in center of oven rack, not touching oven sides.

» Clean oven daily. See "Care & Cleaning" on page 18 of this manual for full instructions.

Cooking Utensils and Containers
ONLY use accessories that are both high temperature oven-safe and microwave-safe.

FOR CONVECTION AND/OR COMBINATION COOKING:

* Maximum metal pan height: 17z inches (38mm). Assure pans do not contact oven or door
surfaces during cooking.

« Different types of metal conduct heat at different speeds. Aluminum heats faster than stainless
steel.

« Line pans with parchment paper for easy removal of food after heating and cleaning.

RECOMMENDED NOT RECOMMENDED

Parchment Paper Aluminum and/or metal foil

Pizza Stone Grocery bags

1/4-size Aluminum Sheet Pan (height < 1% in. (38mm)) | Recycled paper

12in (30cm) Pizza Screen Lead crystal

Ceramic Dish Newspapers

High-temperature glass Metallic trimmed china
Plastic wrap

FOR MICROWAVE-ONLY COOKING:

* Do NOT use cooking containers or covers with metal content. This includes all metal and

enameled metal-core ware, foil, and metal-trimmed containers.
RECOMMENDED NOT RECOMMENDED
Glass/Ceramic Aluminum and/or metal foil
Parchment Paper Grocery bags

Recycled paper

Lead crystal

Newspapers
Metal
Metallic trimmed china

Plastic wrap

Part No. 20290304
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Oven & Control Panel Features

Oven Features

(1) USB PORT / PROTECTIVE COVER
(2) DISPLAY

(3) CONTROL PANEL

(4)

DOOR HANDLE
Ergonomically designed for one handed "Lift and Pull" operation.

(5) AIR INTAKE FILTER (not pictured)
Non-removable air intake filter.

(6) OVEN RACK (not pictured)
The oven is equipped with a removable stainless steel oven rack. 2 available
installation positions.

(7) UNIT SERIAL NUMBER (not pictured)
Located inside the door and on the back of the oven.

Control Panel Features

(A) (A) USB PORT
Standard USB flash drive compatible. Allows for import/export of recipes and user options, and to
update firmware.
(B) DISPLAY
2.8” (71 mm) Color LCD Display
(B) (C) UP KEYPAD
Scrolls up through editable fields and pages.
CULITEK (D) DOWN KEYPAD
Scrolls down through editable fields and pages.
(E) POWER ON/OFF KEYPAD
Preheats oven. Begins cool-down process.
(F) MENU KEYPAD
Opens Main Menu screen to access features including: adjust preheat temperature; edit recipes;
(C) A V (D) manual cook mode; adjust date/time settings; change user options; load menu files; enter service
mode; and/or activate microwave-only cooking.
(E) I — (F) (G) NUMBER KEYPADS
O — Used to operate preset recipes; enter settings; and navigate through display.
(H) STOP/RESET KEYPAD
l 2 Interrupts operation, and/or exits modes and menus.
() START/OK KEYPAD
3 4 Begins cooking in Manual Time Entry Mode. Restarts an interrupted cooking cycle. Used to save
settings and entries.
SR 5|6
(H) O v (0
©2021 Culitek Equipment Part No. 20290304
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Cooking & Programming Features

Cooking Energies and Options

CONVECTION ENERGY

Convection cooking utilizes both a convection element and fan to
evenly distribute heated air throughout the oven cavity. The circulating
air surrounds food in an envelope of evenly heated air. Consistent
temperatures cook food evenly and reduce cooking time. By default,
convection power is enabled. While enabled, oven will maintain a
minimum convection temperature of 200°F (95°C) to ensure drier air
and more even cooking.

MICROWAVE ENERGY

Microwave cooking uses high frequency energy waves to heat the
food. When cooking, microwave energy causes food molecules to
move rapidly. This rapid movement between the food molecules
creates heat, which cooks the food.

Oven generates microwave energy while cooking screen countdowns
and displays power level greater than 0%.

Convection-Only Cooking

To operate with convection-only, use cook
settings with 0% microwave power level.

Combination Cooking:
Convection with Microwave

The combination of both energies uses the
speed of microwave energy and browning
of convection cooking to yield high quality
food faster. To operate with combination
cooking, set convection temperature
between 200°— 475°F (95°— 250°C). and set
microwave power level between 10 — 100%.

Microwave-Only Cooking

Microwave-Only mode allows operator to
disable convection power and cook using
only microwave energy. To operate with
microwave-only, see page 15.

Programming Features
STAGE COOKING

Allows operator to use up to four different cooking cycles or stages consecutively
without repeated input from the operator. For example, stage cooking can be set to
defrost food initially, then cook it, and then finish with more toasting/browning.

PRESET RECIPE KEYPADS
Oven can store between 10 to 100 recipes in memory.
Available quantity varies based on “Digit Entry” User Option.

Note: To change Digit Entry options, see “User Options” section in this manual.

QUANTITY PROMPT

(SELECT MODELS)

Note: Only available when factory option
ALLOW QUANTITY PROMPT is enabled and
Quantity Prompt is enabled in User Options
Allows operator to select preset recipe
keypad(s) for a menu item, followed by the
quantity of items to be heated. Cook times
and settings can be customized for each
recipe in quantities 1-9.

DIGIT ENTRY USER OPTION

AVAILABLE RECIPES

10 recipes (0-9)

Single Digit (10 total recipes)

100 recipes (00-99)

Double Digit (100 total recipes)

10 folders (0-9)
> 10 recipes per folder (0-9)
(100 total recipes)

r._' Folders

Methods of Cooking & Programming
COOKING WITH PRESET RECIPE KEYPADS

Allows operator to quickly activate saved cooking sequences using 1-2 keypad strokes

MANUAL COOKING

Allows operator to heat without changing the preset recipe keypads

MANUALLY EDIT/CREATE NEW PRESET RECIPES

Allows operator to use keypads to edit preset recipes and/or create new recipes for customized cooking.

USB MENU IMPORT AND EXPORT

Allows operator to import and export recipe settings and user options using a standard USB flash drive

©2021 Culitek Equipment
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General Oven Screens

Warming Up
475° F

255° F 475° F

CULITEK

Cooling Down Door Open

260° F

STANDBY WARMING UP READY COOLING DOWN DOOR OPEN
Indicates oven is Indicates oven is ready to Indicates oven is cooling
preheating. Target preheat  operate. The operator may  down. Will display
temperature is displayed press keypads to begin until oven reaches
above the current rising preset recipes or MENU internal temperature of
temperature. keypad for more options. 200°F (95°C).
Menu Clean Filter Reminder (optional)

Press MENU (=) keypad to access list of menu features and functions.
To scroll between pages: Press UP/DOWN (A V) keypads. To access
features, press corresponding number keypad.

Note: If PIN Code is enabled, your unique 4 digit pin code will be required to
access MENU screen

"Menu" Page 1

(1) PREHEAT TEMPERATURE
Allows the operator to change the preheat
temperature between 200°— 475°F

1 | Preheat Temp (95°- 250°C).

|
;\ Edit Recipe

(2) EDIT RECIPE
4 Allows the operator to edit or create new
@ Manual Cook preset recipes/folders for customized cooking.
@ Date/Time (3) MANUAL COOK
Allows the operator to heat without changing

i‘ User Options the preset recipe keypads.

®0 (4) DATE/TIME
(VA SCROLL AIIo_ws the operator to _set Date and Time
settings for their local time.
MENU - PAGE 1 OF 2 (5) USER OPTIONS
Allows the operator to customize various oven
settings.

"Menu" Page 2
(1) LOAD FILE

Menu Allows the operator to upload recipe settings

. and user options using a standard USB flash

|1 Load File drive.

E\ Service Menu (2) :IFRV'CE MENU .

— ows authorized service technicians to

’g Enter MW Only access usage data, troubleshoot, and update
firmware.

Note: Service PIN code required for access.
(3) ENTER MW ONLY
010 Allows operator to disable convection power
(VIA] SCROLL and cook using only microwave energy.

MENU - PAGE 2 OF 2

©2021 Culitek Equipment
Page 8 of 19

Ready 475°F Air filters and vents must be
cleaned regularly to prevent
Clean Filter Reminder: overheating of oven.
cLeanTHEARFILTER | VWhen enabled, clean filter
reminder message will display
once the designated time period
has lapsed.

Complete steps to "Clean Air
Filter" on page 18. Cleaning
the air filters will not shut off message. Message
will automatically stop displaying after 24 hours.
To clear the message, Press START/OK keypad.
Note: To adjust frequency of Clean Air Filter Reminder,
see “User Options” section in this manual.

Preheat Warning (optional)
NELTPIT Y ERY | “Preheat Warning” is
enabled, and oven temperature
Preheat Warning differs from default preheat

Please wait for the temperature, the control will

oven to reach the . .

new temperature interrupt cook cycle and display
warning message, "Please wait
for the oven to reach the new
temperature.”

To exit warning, press START/OK keypad. Once
oven has preheated to desired temperature, you
may begin cook cycle.

Note: To enable/disable Preheat Warning, see

“User Options” section in this manual.

Part No. 20290304
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General Oven Operation

Power-ON Oven, Preheat

Press POWER ON/OFF (()) keypad to begin preheating.
WARMING UP screen will display. READY screen will display
once oven reaches the specified preheat temperature.

Power-OFF Oven, Cool-Down

Press POWER ON/OFF (()) keypad to begin cooling down the
oven. COOLING DOWN screen will display and oven fan will
continue to run. STANDBY screen will display once temperature is

below 200°F (95°C).
E Edit Oven Preheat Temperature
This oven can be set to a preheat temperature between

200°— 475°F (95°— 250°C). It is recommended to set to the most commonly
used temperature for the oven. Factory default setting is 475°F (250°C).
1. Press MENU (=) keypad.

 |If prompted, enter PIN Code and press START/OK keypad.

* MENU screen will display.

2. Press number "1" keypad to access "Preheat Temp".
* PREHEAT TEMP screen will display.

Press number keypads to enter desired temperature.
To save changes: Press START/OK keypad.

To discard changes: Press STOP/RESET keypad.
Set Date and Time

4
E This oven maintains a data log which is used to diagnose and
troubleshoot errors. An accurate date and time are important for the data
log. To set date and time:
1. Press MENU (=) keypad.

 If prompted, enter PIN Code and press START/OK keypad.

* MENU screen will display.

2. Press number "4" keypad to access "Date/Time".
» DATE AND TIME screen will display.

3. To edit date and time fields: Press corresponding number keypad.
» Active editable field is highlighted in red.
+ Editable fields include:

(1) Day

(2) Month
(3) Year

(4) Hours
(5) Minutes

(6) AM/PM/24
Press UP/DOWN (A V) keypads to scroll to correct setting per field.
To save and exit: Press START/OK keypad.
To discard changes: Press STOP/RESET keypad.

©2021 Culitek Equipment
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Of |

Warming Up
475° F

255° F

WARMING UP READY

Cooling Down

CULITEK

260° F

STANDBY

COOLING DOWN

Interrupt Operation
Press STOP/RESET keypad

to interrupt operation. Display
continues to show countdown time.
Close door and press START/OK
keypad to resume oven operation.

Cancel Mistakes

If oven is not cooking, press STOP/
RESET keypad to clear display.

If oven is cooking, press STOP/
RESET keypad twice to stop and
clear display.

Part No. 20290304
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Manual Cook Mode

Manual Cook Screens

MANUAL COOK ENTRY

Displays while operator is entering cook settings in Manual Cook mode.
Active editable field is highlighted in red.

To navigate to editable fields: Press UP/DOWN (A V) keypads.

Ready 475°F
Manual Cook

Ready 475°F
Manual Cook

Ready "Manual Cook" Editable Fields:
Manual Cook (A) OVEN TEMPERATURE**

) —4 & wwonLy Between 200°- 475°F (95°- 250°C). Defaults to
[] all (-] all & all oven preheat temperature.
(B) — BT 1:00 | 80% B)_ll 130 20% [ () (B) COOK TIME (PER STAGE)
(D) O STAGE 1:30 | 30% I RN N 100% Combined total cook time cannot exceed 20:00.
(D) © STAGE

1:15 50%
© STAGE

DEL STAGE [¥] cook

MANUAL COOK ENTRY
3 cooking stages used.

Stage 3 Power Level field is
highlighted/editable.

(C) %MW POWER LEVEL (PER STAGE)
Percent microwave power from 0-100% in 10%
increments (keypad "0" = 0%, keypad “1"=10%,

V]A] scroLL [#) cook DEL STAGE [¥] cook

MANUAL COOK ENTRY
1 cooking stage used.

Stage 1 Cook Time field is
highlighted/editable.

MANUAL COOK ENTRY “9"=900
In MW-Only Mode**. keypad '2'=20%,etc.)

2 cooking stages used. qu 100% power level, press any number keypad
Stage 2 Cook TIme field is twice.
highlighted/editable. (D) ADD A STAGE

Up to four stages can be entered.

Manual Cooking

Allows operator to heat without changing the preset recipe keypads.
Note: Oven must be preheated before combination or convection cooking.

BE

Menu

From READY or DOOR OPEN screen: 1 pelee et
1. Open oven door, place food in oven, and close door. | 2 Edit Recipe
« READY screen will display. } l\DAatneL;'?!nCSOk
a m
2. Press MENU (=) keypad. 5 | User.Options
» If prompted, enter PIN Code and press START/OK keypad. ®©0
* MENU screen will display. VIALSGROLL
3. Press number "3" keypad to access "Manual Cook". ———
« MANUAL COOK ENTRY screen will display. Manui, Cook Manual Cook
4. To navigate to editable fields: Press UP/DOWN (A V) keypads. 8 §
» Active editable field is highlighted in red. T —
« Editable fields include: © STAGE
> Oven Temperature™*
o Cook Time (per stage)
> %MW Power Level (per stage) VIA] scrOLL [#) cook @ DEL sTAGE @ cook
o Add a Stage
Press number keypads to enter desired settings per field. a1l 80%
To add additional cooking stages: Press DOWN (V) keypad until “+ STAGE” -
. . . Manual Cook Manual Cook
is highlighted.
* Anew row of Cook Time and %MW Power Level fields will display
+ Repeat steps 4-6 for each additional stage. 3:29
7. Press START/OK keypad to begin cooking.
» Oven operates and display counts down cooking time.
8. At the end of the cooking cycle, the oven beeps. Oven interior and cooking dish

I3

will be hot. Carefully remove food from oven.

If Microwave-Only Mode is enabled, then Oven Temperature will read "MW ONLY" and will not be an

editable field. See page 15 for details.

©2021 Culitek Equipment
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Operating Preset Recipe Keypads

Operating Preset Recipe Keypads

This oven can store up to 10 or 100 recipes in memory. To heat using a preset
recipe, press number keypad(s). Oven will start to heat automatically.
Note: Oven must be preheated before combination or convection cooking.
From READY or DOOR OPEN screen:
1. Open oven door, place food in oven, and close oven door.
* READY screen is displayed.

2. Press desired number keypad(s):
« Single Digit Keypad Cooking: Press a single keypad (0-9).
» Double Digit Keypad Cooking: Press two keypads, in order, of the double
digit number for the desired recipe (00-99).
» Folders: Press one keypad to open folder (0-9), followed by keypad for a1l 30%
desired recipe (0-9).
Note: To change Digit Entry option see "User Options" section in this manual Lava Cake

| e aea——
3. Oven operates and time counts down.

« Display shows recipe name, and counts down cooking time. 2 - 53
« |f additional cooking time is required, press preset keypad(s) before or after
cooking cycle ends.

4. Atthe end of the cooking cycle, the oven beeps. Oven interior and cooking
dish will be hot. Carefully remove food from oven.

Operating Preset Recipe Keypads with
Quantity Prompt (select models)

Allows operator to select preset recipe keypad(s) for a menu item, followed by
the quantity of items to be heated (1-9).
1. Press desired number keypad(s).

« ENTER QUANTITY screen is displayed. 6

2. Enter desired quantity using keypad 1-9.
» Display shows the recipe name and counts down cooking time.
» Quantity is displayed before the recipe name. (X1, X2, X3, etc.)

Ready 475°F

Enter Quantity

©2021 Culitek Equipment
Page 11 of 19

il 30%

X6 Pretzels
| r e

1:49
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Edit Recipe Screens

Edit Recipe List Screens somneciELisT  COIEEISR FoIT RECIPE LisT
Indicates oven is entering "Edit Recipe" 2 Available Page 2 of 2 shown. 00)- Available Page 1 of 20 shown.
mode. The operator may press keypads to (7]- Available (01) Biscuits
open recipe and/or folder locations. (A) - Available (CIRRN 02 Lava Cake
- - Availabl 03}s,
Note: Screens may vary based on Digit Entry s | o
tion in "User Options” - Available 04]- Available
optionin P (B) (B) —Eeee s oeses
(A) RECIPE/FOLDER LOCATIONS VIA] scROLL
Numbers represent programmed recipes and
available memory locations. Unused locations
are labeled “- Available.” Operator may press
keypad(s) to view and edit locations.
Edit Recipe EDIT RECIPE LIST Edit Recipe EDIT RECIPE LIST
(B) MULTIPLE PAGES Folders Digit Entry. (C)— IETES Folders Digit Entry.
Radio button icons indicate page number. 1 Breakfast ;OP ’91"9’%2 . 1 Biscuite I’:O;gef ; is Ol?e”t- .
A age 1 o shown. — older 1 contents shown.
Operator may press UP/DOWN (A V) 12¥ Lunch g " 2 | Breakfast Sandwich [N SN "
keypads to scroll between pages. 18] pinner (el (3] Available '
(C) PARENT FOLDER LOCATION »g}"*vai'ab'e 4] Available
If folder location is opened, the contents of LD Aailege 5 - Available
e (B) ©0

the selected folder are displayed. Parent
folder location is displayed above the first
recipe on each page.

V] Al scroLL V]A] scroLL [@ BACK

Edit Recipe Entry Screens Edit Name Screens

Displays while a recipe or folder location is open. Displays while editing name of recipe or folder™.
Stored location is represented by number at top right corner of screen. Operator may press number keypads to enter
Active editable field is highlighted in red. a name. To cycle through available characters:
To navigate to editable fields, press UP/DOWN (A V) keypads. Press same keypad within 1 second.

Edit Name ‘a‘

NUM SYM

ABcD Y EFGH

Edit Name
Breakfast

NUM SYM

ABcD [ EFGH

Edit Recipe 04] PN Edit Recipe /7/( 3]
|Recipe Name

|Cheese Pizza

)
(] il

N 100 sov - E
: . (E) F € Bix. B wvnor B« Bwmnor
Pl 1:30 0 30% (F) O STAGE
3 EEETE 0% osrT B uvw QsrT B uvw
© STAGE Bxz B
B DEL STAGE (¥ SAVE V|A] scrOLL (& SAVE
EDIT RECIPE ENTRY EDIT RECIPE ENTRY EDIT RECIPE NAME EDIT FOLDER NAME*
Double Digit Entry. Folders Digit Entry. Double Digit Entry. Folders Digit Entry.
Recipe Location "04" shown. Recipe Location "3" within Folder "1" shown. Location "04" shown. Location "1" shown.
Stage 3 Power Level field is Oven Temperature field is highlighted/editable.
highlighted/editable.
"Edit Recipe Entry” Editable Fields: “Edit Name" Keypad Functions
(A) g‘AK; ngLDET,; F°|’-:DIER t‘AME* a il KEYPAD | DESCRIPTION TEXT FUNCTION
ee "Edit Recipe Mode: Folders" on page or details. 1 NUM 1234567890
(B) REc"IPI_E NAME L 2 SYM L& ()~ @#S %N+
See "Edit Name Screens" section. 3 ABCD ABCDabcd
(C) OVEN TEMPERATURE 4 EFGH EFGHefgh
Between 200°— 475°F (95°— 250°C). Defaults to oven preheat temperature. 5 UKL ILKijlk
(D) COOK TIME (PER STAGE) 6 MNOP MNOPmnop
Combined total cook time cannot exceed 20:00. 7 QRST QRSTarst
(E) %MW POWER LEVEL (PER STAGE) 8 uvw UVWuvw
Percent microwave power from 0-100% in 10% increments 9 XYz XYZxyz
(keypad "0" = 0%, keypad “1"=10%, keypad “2"=20%,etc.) 0 (space)
0, . —
For 100% power level, press any number keypad twice. START OK (save and exit)
(F) ADD A STAGE STOP <- (backspace)

Up to four stages can be entered.

*  Make Folder and Folder Name are only available when User Options>Digit Entry>Folders is enabled and location is in top level (0-9) of Edit Recipe List.
See page 14 for details.

©2021 Culitek Equipment Part No. 20290304
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Edit or Create New Recipes
Allows the operator to edit or create new preset recipes/folders for

Edit Recipe Mode
customized cooking. This oven can be programmed to store up to 10

=
or 100 preset recipes in memory.

1. Press MENU (=) keypad.
» If prompted, enter PIN Code and press START/OK keypad.
* MENU screen will display.

2. Press number "2" keypad to access "Edit Recipe".
» EDIT RECIPE LIST screen is displayed with list of preset recipes, folders,
and/or available locations.
» To scroll between pages of recipes: Press UP/DOWN (A V) keypads.

3. Press number keypad(s) to open the desired recipe/folder location.
« EDIT RECIPE ENTRY screen will display.

4. To navigate to editable fields: Press UP/DOWN ( A V) keypads.
+ Active editable field is highlighted in red.
+ Editable fields include:
o Make Folder and Folder Name*™
o Recipe Name
o Oven Temperature**
o Cook Time (per stage)
o %MW Power Level (per stage)
o Add a Stage

Press number keypads to enter desired settings per field.

To add additional cooking stages:

Press DOWN (V) keypad until “+ STAGE” is highlighted.

* Anew row of Cook Time and %MW Power Level fields will display.
» Repeat steps 4-6 for each additional stage.

To save and exit: Press START/OK keypad.
To discard changes: Press STOP/RESET keypad.

* Make Folder and Folder Name are only available when User Options>Digit Entry>Folders is enabled and
location is in top level (0-9) of Edit Recipe List. See page 14 for details.

**If Microwave-Only Mode is enabled, then Oven Temperature will read "MW ONLY" and will not be an
editable field. See "Microwave-Only Mode" section on page 15 for details.

Edit or Create New Recipes with Quantity Prompt

(select models)
Cook times and settings can be customized for each recipe in quantities 1-9.
To edit the settings of a specific recipe/quantity:
1. Complete steps 1-3 in "Edit or Create New Recipes".
+ ENTER QUANTITY screen is displayed.

2. Enter desired quantity using keypad 1-9.
» EDIT RECIPE ENTRY screen will display.
* Quantity is displayed before the recipe name. (X1, X2, X3, etc.)

3. Complete steps 4-7 in "Edit or Create New Recipes".

©2021 Culitek Equipment
Page 13 of 19

Menu

J Preheat Temp.
‘72 Edit Recipe

3| Manual Cook

4] Date/Time

5 | User.Options
(Ole]

V] Al scrROLL

Edit Recipe 4]

[Recipe Name
8
(] all

1 :00  100%
© STAGE

VIA] sCROLL & SAVE
Default

4-5 Edit Name

NUM SYM

ABcD Y EFGH

Edit Recipe Name

Edit Recipe
[Flatbread Pizza

(]
A o0

© STAGE

VIA] SCROLL & SAVE
Stage 1, %MW Power

Edit Recipe

1 ) Biscuits
‘jZ Lava Cake
(3 scones
| 4 |- Available
|5 - Available

®0
V/|A] scrOLL

Edit Recipe 4]

[Recipe Name
g mwonLy
© all
1] :00

© STAGE

V|A] scroLL [ SAVE
In MW-Only Mode™*

Edit Recipe 4|

Flatbrea'd Pi;za —
o
1

SR 100%

© STAGE

V|A] scrOLL [#] sAVE
Stage 1, Cook Time

6 Edit Recipe (4]
I 475°F
(-] Ja
i 100 80%
2 [ 1:30 LA
© STAGE

B DEL STAGE [¥] SAVE

Stage 2, Cook Time
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Edit Recipe Mode: Folders

Allows operator to organize recipes in folders. Folders can only be located in the top
level (0-9) of EDIT RECIPE LIST. Folders cannot be created within folders.
Note: Folders must first be enabled in User Options>Digit Entry>Folders.

Navigate Existing Folders
From EDIT RECIPE LIST screen:

* To open folder: Press number keypad to open the desired folder.
» To exit folder: Press STOP/RESET keypad.

Create New Folders

1.  Press MENU (=) keypad.
2. Press number "2" keypad to access "Edit Recipe".
» EDIT RECIPE LIST screen will display.
» To scroll between pages of recipes: Press UP/DOWN (A V) keypads.
3. Press a number keypad to open the desired recipe/folder location.
» EDIT RECIPE ENTRY screen will display.
Press UP (A) keypad to navigate to Recipe Name field.
» EDIT RECIPE NAME screen will display.
5. To make folder: Press UP(A) keypad to access MAKE FOLDER screen.
* MAKE FOLDER screen will display.
» Press START/OK keypad to make folder.
» EDIT FOLDER NAME screen will display.
To enter folder name: Press number keypads to enter folder name.
To save folder: Press START/OK keypad.
+ Folder will now be visible on EDIT RECIPE LIST screen.

»

No

Edit or Create New Recipes Within Folders
1.  Complete steps 1-2 in "Create New Folders" section above.
2. Press a number keypad to open the desired folder location.
» EDIT RECIPE LIST screen is displayed with contents of the selected folder. Parent
folder location is displayed above the first recipe on each page.
» To scroll between pages of recipes: Press UP/DOWN (A V) keypads.
3. Press a number keypad to open the desired recipe location within the folder.
» EDIT RECIPE ENTRY screen is displayed, with parent folder location displayed to
the left of the current recipe location.
4. To create recipe: Complete steps 4-7 in "Edit or Create New Recipes" on page 13.

Edit Folder Name

From EDIT RECIPE LIST screen:
1. Press and hold number keypad of corresponding folder.
» EDIT FOLDER NAME screen will display.
2. Press number keypads to edit folder name.
3. To save changes and exit folder: Press START/OK keypad.

Delete Folder
Caution: Deleting a folder will make its contents inaccessible.
From EDIT RECIPE LIST screen:
1. Press and hold number keypad to corresponding folder.
» EDIT FOLDER NAME screen will display.
2. Press UP (A) keypad.
» DELETE FOLDER screen is displayed.
3. To delete folder: Press START/OK keypad.
4. Press START/OK keypad again to exit EDIT RECIPE NAME screen.
5. To save changes and exit: Press START/OK keypad.

©2021 Culitek Equipment
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Menu

1 JPreheat Temp

| 2 | Edit Recipe
3 |Manual Cook

4 | Date/Time

|5 | User Options
Cle;

V| Al scrOLL

Edit Recipe 1 }
[Recipe Name

i
© Jal

1 :00 | 100%

num B sy
ABCD Y EFGH
ke B mnop
QsrT Buvw

Edit Recipe
1 Breakfast
1| Biscuits
| 2| Breakfast Sandwich
3 )~ Available
4 | - Available
5 |- Available
Ole]
V/|Al scrOLL BACK

Edit Name

num B sym
ABCD B EFGH
ke B mnop
QskT B uvw

Edit Name

NUM SYM
ABCD Y EFGH
ke Ewmn
QsrT B uv
Bxz @_
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o
-
o
]
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- Available
- Available
- Available
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>
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(o}
=
[e]
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Edit Name

K num SYM
ABCD Y EFGH

num B sym
ABCD B EFGH
ke B mnop
QskT B uvw

Edit Recipe

1 Breakfast
2] Available
3 |- Available
4 |- Available
|5 |- Available
®0
V/IA] scrOLL

Edit Recipe ‘ 1
Recipe Name
|8 475°F
© all
1

© STAGE

VIA] scrOLL [ SAVE

Edit Name

K num SYM
ascD B EFGH
ke B mnop

Delete Folder?
NuM B sym
ABCD Y EFGH
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Microwave-Only Mode

Microwave-Only Mode (MW-Only Mode) allows operator to disable convection power
and cook using only microwave energy.

E ﬂ B Enter MW-Only Mode

Cooling Down

Oven must cool-down before microwave-only mode can be 260° F
enabled.
1. If oven is preheated, Press POWER ON/OFF (()) keypad to begin cooling-down
the oven.

* COOLING DOWN screen will display until oven temperature is below 200°F (95°C).
» Once cooled, STANDBY screen will display.

2. Press MENU (=) keypad.
» |If prompted, enter PIN Code and press START/OK keypad.
* MENU screen will display.

Press DOWN (V) keypad to scroll to second page of MENU.

|1 /Load File
| 2 |service Menu
3

Enter MW.Only.

o®
4. Press number "3" keypad to activate "Enter MW Only". V] A scROLL

* Oven will now be in Microwave Only Mode.
* "Enter MW Only" item on MENU screen will change to "Exit MW Only".

5. To exit MENU: Press STOP/RESET keypad.
* READY: MW ONLY screen is displayed.

Exit MW-Only Mode
Press POWER ON/OFF (()) keypad to exit microwave-only mode and begin
preheating the oven. WARMING UP screen displays. READY screen will
display once oven reaches the specified preheat temperature.

Manual Cook in MW-Only Mode
1. Oven must be in MW-Only Mode first. See "Enter MW-Only Mode".

2. Complete steps in "Manual Cooking" on page 10.
* Oven Temperature will read "MW ONLY" and will not be an editable field.

Operating Preset Recipe Keypads in MW-Only Mode

This oven can store up to 10 preset "MW-Only" recipes in memory.
1. Oven must be in MW-Only Mode first. See "Enter MW-Only Mode".

2. Complete steps in "Operating Preset Recipe Keypads" on page 11.

Edit Recipe in MW-Only Mode

This oven can be programmed to store up to 10 preset "MW-Only" recipes in memory.
1. Oven must be in MW-Only Mode first. See "Enter MW-Only Mode".

2. Complete steps in "Edit or Create New Recipes"” on page 13.
* Oven Temperature will read "MW ONLY" and will not be an editable field.

©2021 Culitek Equipment
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Menu

l Preheat Temp
| 2] Edit Recipe

| 3 |Manual Cook

(4] Date/Time
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USB Flash Drive

E E . Import Menu from USB Flash Drive

Note: Menu file must be . XML format. Menu file must be saved at the root
directory of the flash drive, and cannot be located inside any folders. Preheat Temp

Flip open USB port protective cover. Insert flash drive into the USB port. ;‘“t Relcépek
anual Coo
2. Press MENU (=) keypad. Date/Time
 If prompted, enter PIN Code and press START/OK keypad. User.Options @
* MENU screen will display. Ole}
- V/|A| SCROLL

Press DOWN (V) keypad to scroll to second page of MENU.
Press number "1" keypad to access "Load File". Load File
» LOAD FILE screen displays with list of . XML files on the root directory of the flash Load File 1 | FileNameA.xm|

drive, and an option to "Export to USB". 2] Service Menu (2] FileNameB xmi
 If more than 4 recipes files are on the flash drive: Press UP/DOWN (A V) keypads to Enter MW Only. 3 FileNameC.xm|

scroll through pages of files.
) . 5 [Export toUSB
5. Toload a file: Press corresponding number keypad. e —ry

* If upload was successful: "Loaded OK" will display. Settings and menu items will be V1A SCROLL @ sac
loaded on the oven.
« If upload failed: "Error Loading" will display.

6. Press STOP/RESET keypad to exit. Remove USB Flash Drive.

TROUBLESHOOTING:
USB flash drive must be inserted prior to selecting "Load File."
* Press STOP/RESET keypad to exit LOAD FILE screen. Insert flash drive and retry transfer.
b [If the error persists: Open USB flash drive on computer and verify that menu file is in .XML
format and saved in the root directory of the flash drive. Retry transfer.
b If the error persists: Unplug oven from outlet and plug-in oven. Retry transfer.

E ﬂ . . Export Menu to USB Flash Drive ol [oadrly
|1 JFileNameA.xml 1 JFileNameA.xml

Flip open USB port protective cover. Insert flash drive into the USB port. 2 | FileNameB.xml 2 |FileNameB.xml

3 | FileNameC.xml 3 | FileNameC.xml
2. Press MENU (=) keypad.
» If prompted, enter PIN Code and press START/OK keypad. ExPorfta 5 [Export to 0SB~ |
* MENU screen will display. e -

Press DOWN (V) keypad to scroll to second page of MENU.

B Back

Press number "1" keypad to access "Load File".

» LOAD FILE screen displays with list of .XML files on the root directory of the flash R
drive, and an option to "Export to USB". Update Firmware

Note: Firmware files must be loaded

on USB flash drive. Must be saved at

the root directory of the flash drive, and

cannot be located inside any folders.

5. Press number "5" keypad to access "Export to USB". Oven will begin to export to
USB flash drive.
« If export was successful: "Export OK" will display. Settings, menu items, and oven

usage data will be loaded on USB Flash Drive. 1. Flip open USB port protective
« If export failed: "Export Failed" will display. cover. Insert flash drive into the
6. Press STOP/RESET keypad to exit. Remove USB Flash Drive. USBport.
TROUBLESHOOTING: 2. Press MENU (=) keypad.
) ) . o N 3. Press DOWN (V) keypad to
USB flash drive must be inserted prior to selecting "Export to USB.
. scroll to second page of MENU.
* Insert flash drive and retry transfer. e
4.  Press number "2" keypad to

access "Service Menu".
* PIN Code prompt appears.

5. Press keypads 1-3-5-7-9 to enter
SERVICE MENU.

6. Press and hold number "7"
keypad for 3 seconds to initiate
firmware update.

TROUBLESHOOTING:

If firmware fails to load: Press and hold
STOP/RESET keypad while plugging in
the oven.

©2021 Culitek Equipment Part No. 20290304
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User Options

There are several options you can change to customize the operation of the oven.
Options are shown below. The factory setting is shown in bold type.

E Access and Modify User Options

1. Press MENU (=
 If prompted, enter PIN Code and press START/OK keypad.

) keypad.

* MENU screen will display.

2. Press number "5" keypad to access "User Options".
+ USER OPTIONS screen will display with list of customizable settings.
+ To scroll between pages of settings: Press UP/DOWN (A V) keypads.

3. To access available options for a setting: Press corresponding number keypad.
» The currently selected option is highlighted in red.

4. To change a setting: Press corresponding number keypad.
» The newly selected option is highlighted in red.

To save changes: START/OK keypad.
To exit: Press STOP/RESET keypad.

STANDARD DEFAULT PER MODEL (FACTORY SETTINGS IN BOLD)

Factory setting may vary by model

User Options

End of Cycle Beep

Speaker Volume
Key Beep

Reset on Door Open

| Digit Entry,

®00

Maximum Cook Time
Keypad Enable Windoj

n-the-Fly Programm
C\ean Filter Reminder

| Preheat Warning

User Options

Auto Shut-Off
PIN Code
Language

Temperature Unit

il
B
3
(4]

[ \

Quantity Prompt

Oo®
VJ]A] scrOLL

SETTING DISPLAYED OPTIONS | DESCRIPTION
End of Cycle Beep 3 Seconds 3 second continuous beep
Continuous Continuous beep until door is opened
Burst 5 beep bursts until door is open
Speaker Volume Off Sets volume to off
Low Sets volume to low
Medium Sets volume to medium
High Sets volume to high
Key Beep Off Prevents beep when keypad is pressed
On Allows beep when keypad is pressed

Reset on Door Open

End Cook Cycle
Pause Cook Cycle

Cancels heating time count down after door is opened during cycle.
Allows oven to resume heating time countdown after door is opened during cycle

Digit Entry Single Digit Allows 10 (0-9) preprogrammed recipes

Double Digit Allows 100 (00-99) preprogrammed recipes

Folders Allows 10 folders (0-9), each with 10 preprogrammed recipes
Maximum Cook Time 10 minutes Allows 10 minutes of heating time

20 minutes Allows 20 minutes of heating time
Keypad Enable Window 15 seconds 15 seconds after oven door is opened, keyboard disabled

30 seconds 30 seconds after oven door is opened, keyboard disabled

1 minute 1 minute after oven door is opened, keyboard disabled

2 minutes 2 minutes after oven door is opened, keyboard disabled
On-the-Fly Programming | Off Disables pushing any additional keypads during a cook cycle

On Allows pushing additional keypads to add or change time in the middle of a cook cycle
Clean Filter Reminder Off Oven will not display “Clean Filter Message”

Every 7 Days Oven will display “Clean Filter Message” every 7 days

Every 30 Days
Every 90 Days

Oven will display “Clean Filter Message” every 30 days
Oven will display “Clean Filter Message” every 90 days

Preheat Warning Enabled Oven will display warning message if recipe temperature does not match oven temperature
Disabled Oven will not display temperature warning message
Auto Shut-Off Never Oven will not automatically shut-off
2 Hours After 2 hours of inactivity, oven will automatically shut-off
4 Hours After 4 hours of inactivity, oven will automatically shut-off
8 Hours After 8 hours of inactivity, oven will automatically shut-off
PIN Code Off PIN Code not required to access Menu or User Options
On PIN Code required to access Menu and User Options
Set PIN Code PIN Code required. Create new 4 digit PIN Code
Language Chinese (Mandarin), Danish, Dutch, English, Filipino, French, German, Greek, Italian, Japanese, Korean, Norwegian, Polish,

Portuguese, Romanian, Russian, Spanish, Swedish, Ukrainian, Viethamese

Temperature Unit Fahrenheit Temperatures are displayed in Fahrenheit for 60Hz models
Celsius Temperatures are displayed in Celsius for 50Hz models

Quantity Prompt** Oon Prompts the user for portion quantity multiplier (1-9) upon selecting a preset recipe
Off Allows user to cook individual portions

** Available on select models only. (Only displayed in User Options menu if factory option is enabled)

©2021 Culitek Equipment
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Care & Cleaning

Convection and microwave energies are attracted to any food source in the oven. Moisture, spills,
and grease can affect heating performance and may cause oven damage. To prevent damage to
oven, clean oven frequently and remove any food debris. Follow the recommendations below.
A CAUTION: NOT FOLLOWING APPROVED OVEN CLEANING INSTRUCTIONS
MAY VOID YOUR OVEN WARRANTY.

A Do NOT use abrasive cleaners or cleaners containing ammonia, citrus, phosphates, chlorine,
sodium or potassium hydroxide (lye). The use of caustic cleaning products or those containing
ammonia, citrus, phosphates, chlorine, sodium or potassium hydroxide (lye) can damage critical
oven parts. Use of unapproved cleaning agents will void the terms of warranty.

A Do NOT use water pressure type cleaning systems.

A ALWAYS unplug oven before cleaning.

A Do NOT spray any cleaning solution directly onto back-wall perforations.

RECOMMENDED CLEANING SUPPLIES:
Damp towel, plastic scouring pad, mild liquid dishwashing detergent, rubber gloves, safety
glasses, microfiber cloth.

Daily Care and Cleaning

PREPARE OVEN

1. Press Power ON/OFF keypad to power-off oven. The fan will run to cool the oven
interior faster. Allow oven to cool down to 200°F (95°C) (Approximately 10—15 minutes
with the door open and 45-60 minutes with the door closed).

2. Once cooled, carefully remove oven rack and other accessories from the cavity.

CLEAN OVEN RACK AND ACCESSORIES

3. Clean the oven rack with liquid dishwashing detergent such as Dawn®, and a non-
abrasive sponge or soft bristle brush. Allow to air-dry.

4. For other accessories, please refer to instructions included in original packaging.

CLEAN OVEN INTERIOR

5. Remove baked-on particles using a plastic scouring pad.

6. CLEAN AND WIPE OVEN INTERIOR: Wipe the oven interior with mild detergent using
a damp clean towel. Wring sponge or cloth to remove excess water before wiping
equipment. Rinse towel and wring dry. Repeat 2—3 times to remove remaining
detergent and debris.

7. Reinstall oven rack in oven.

CLEAN OVEN EXTERIOR
8. CLEAN EXTERIOR DOOR AND SURFACES with a clean cloth, sponge or nylon pad; using a

mild detergent and warm water solution.
CLEAN CONTROL PAD AND SCREEN with a dry or damp microfiber cloth.

9.
A Do NOT use Windex or other harsh chemicals. Do NOT spray liquid on the screen.

Weekly Cleaning

CLEAN AIR FILTER
Air filter is located below oven door.
10. Wipe louvers using a damp clean towel.

©2021 Culitek Equipment
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/\ WARNING

To avoid electrical shock which can
cause severe personal injury or death,
unplug power cord or open circuit
breaker to oven before cleaning.

To prevent burns, handle utensils,
rack, accessories, and door with
care. Allow oven, utensils, rack, and
accessories to cool before cleaning.
Oven, utensils, and accessories
become hot during operation

Wear protective gloves and protective
glasses when cleaning the oven.

Failure to maintain the oven in a clean
condition could lead to deterioration of
the surface that could adversely affect
the life of the appliance and possibly
result in a hazardous situation.
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Before Calling for Service

Record all inspections and repair for future reference.

/\ WARNING

To avoid electrical shock which can cause severe personal injury or death, do not remove outer case at any time. Only an
authorized servicer should remove outer case.

This is a Class A product. In a domestic environment this product may cause radio interference in which case the user may be
required to take adequate measures.

SYMPTOM

POSSIBLE CAUSE

Oven fan turns on while oven is not
preheating or cooking.

Normal operation

Oven does not operate

Confirm oven is plugged in.

Check fuse or circuit breaker.

Confirm oven is plugged into dedicated circuit.

Confirm oven is on grounded and polarized circuit. Contact electrician to confirm.

“CLEAN FILTER” shows in display.

This is normal and will appear for 24 hours.
» Complete steps to "Clean Air Filter" on page 18.
» To clear the message, Press START/OK keypad.

If oven does not accept entries
when keypad is pressed

Make sure oven is on and preheated.
Open and close oven door. Press keypad again.
Check User Option>Digit Entry.

"EXCEEDS MAXIMUM COOK
TIME" shows in display.

Total cook time exceeds the maximum allowable.
» Check cook times per stage.
» Check User Option>Maximum Cook Time.

“INVALID ENTRY” shows in
display.

PIN Code entered is incorrect, or cook time is zero or unset.
» Correct entry. Retry.

"OVEN HOT!" shows in display.

Cavity temperature exceeded the limit.
»  Wait for 30 minutes for cavity to cool down.
b If error continues to show in display: Unplug oven, wait for 1 minute. Plug-in oven.
b If the error persists, please call for service.

"ERROR 7: RTD OUT OF RANGE"
shows in display.

RTD was exposed to momentary spike.
* Unplug oven, wait for 1 minute. Plug-in oven.
b If the error persists, please call for service.

"ERROR 5: STUCK KEY" shows
in display.

A keypad is actuated continuously or there is an issue with the keypad.
» Ensure the keypad is not in contact with anything.
b If the error persists, please call for service.

CONTACT INFORMATION

Any questions or to locate an authorized service provider to perform warranty service:

1. Locate the model and serial number on the service plate.
2. Call Culitek Service Support. Phone: 1-800-436-9472

CULITEK

Commercial Service
800-436-9472

Warranty service must be performed by an authorized Culitek servicer. Culitek also recommends contacting an authorized service
provider for support after warranty has expired.

©2021 Culitek Equipment
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